
Release Notes for Modo 12.0v1
Release Date

March 28, 2018

System Requirements

Officially Supported Operating Systems
• MacOS 10.10.x, 10.11.x, and 10.12.x (64-bit only)
•Windows 7,Windows 8, andWindows 10 (64-bit only)
• Linux 64-bit operating system (CentOS/RHEL 7+)

Minimum Hardware Requirements
• Intel processor(s), Core i3 or higher
• 1 GB available hard disk space (for Modo installation).
• 6 GB available hard disk space (for full content).
• At least 4 GB RAM
• Display with 1920 x 1080 pixel resolution
• Internet connection for product activation and online videos access
• The Advanced viewport mode requires an NVIDIA or AMD graphics card with at least 1 GB of graphics
memory and drivers that support OpenGL 3.2 or higher.

Recommended System Requirements

NOTE: This information is our best recommendation for the average user. Requirements vary by
usage, and individual usersmay have different requirements from those listed here.

• 2.5+ GHz quad-core processor
• 250+ GB disk space available for caching and temporary files, SSD is preferable
• 16GB RAMwith additional virtual memory*
• Display with 1920 x 1080 pixel resolution
• An NVIDIA or AMD graphics card with the latest drivers
• 2+ GB of graphicsmemory
• OpenGL 4.4 or higher support
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*The use of virtual memory improves stability and helps prevent data loss on large projects.

TestedWorkstation Hardware

The configurations listed below are those that Foundry have tested with Modo. Due to the constantly changing
nature and wide variety of computer hardware available in themarket, Foundry is unable to officially certify
hardware. The list below can be used as a recommendation and does not guarantee that it meets your particular
needs.

Please download and install the latest graphics driver from the NVIDIA or AMD websites. Make sure that you
are using 8.982.8.1 drivers or higher for AMD cards.

If you encounter any issues, please visit the Support Portal at https://support.foundry.com.

Tested Workstation Hardware

Apple • MacBook Pro 2017
• MacBook Pro (Mid 2015)
• MacBook Pro 2014
• MacPro (Late 2013)
• MacBook Pro10, 1
• MacPro4, 1
• MacPro5, 1
• iMac13, 2

Dell • Dell T1700
• Dell T3610
• Dell T3620
• Dell T5810
• Dell T7610
• Dell T7910
• Dell Precision 3520
• Dell Precision Rack 7910
• Dell Precision 5510
• Dell Precision 5520
• Dell Precision 7710
• Dell Precision 7720
• Dell M2800
• Dell M6800
• Dell XPS 15 9560

HP • HP Z800
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Tested Workstation Hardware

• HP Z640
• HP Z620
• HP Z600
• HP Z440

Tested GPU Hardware

AMD Prosumer Graphics Cards • Radeon™ HD 1900 XT
• Radeon™ HD 2400 XT
• Radeon™ HD 2600 Pro
• Radeon™ HD 3870

AMD Enterprise Graphics Cards • FirePro™ D700
• FirePro™W4170
• FirePro™W5000
• FirePro™W8000
• FirePro™W2100
• FirePro™W5100
• FirePro™W4100
• FirePro™W7100
• FirePro™W8100
• FirePro™W9100
• Radeon Pro 560
• Radeon ProWX7100
• Radeon ProWX5100
• Radeon ProWX4100
• Radeon R9M370X

NVIDIA Prosumer Graphics Cards • Geforce GT 750M
• Geforce GTX 680
• Geforce GTX Titan
• Geforce GT 650M
• Geforce GTX 1080 Ti
• Geforce GTX 1080

NVIDIA Enterprise Graphics Cards • Quadro® K6000
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Tested GPU Hardware

• Quadro® K5200
• Quadro® K5000
• Quadro® K4200
• Quadro® K4000
• Quadro® K2200
• Quadro® K2000
• Quadro® K1200
• Quadro® K600
• Quadro® K620
• Quadro®M5000
• Quadro®M4000
• Quadro® P4000
• Quadro®M620

NVIDIA Quadro Graphics Cards: • P400
• P600
• P1000
• P4000
• P5000

New Features

Advanced 3DViewport GPUAcceleration

The Advanced 3D Viewport in Modo now usesMulti Sample Anti-Aliasing (MSAA) GPU hardware to speed up
anti-aliased rendering. Enabling the new Multisampling option processes renderings faster. A new GPU
powered Anisotropic texture filtering option, Anisotropic Filtering, provides superior viewport texture quality at
the slight expense of performance. Anisotropic filtering improves the clarity and crispness of textured objects
processed by theGPU in order to give a realistic 3D viewport experience.

For more information, see 3D (OpenGL) Viewport.

Cloud Assets and Foundry Share Site

Creating, sharing, and downloading preset assets has been improved inModo 12.0. Cloud Assets can now be
dragged and dropped into the Items list or directly into the 3D viewport. If you prefer to download the assets and
not apply them to your scene, you can use the new download button that appears in the upper right of the preset
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thumbnail. An info button is also available on the lower right of the thumbnail to bring up details about the asset
from the share site.

In addition, the preset creation workflow is now simplified. Selected items can be dragged and dropped into the
Preset Browser.

For more information, see Preset Browser and Creating Your Own Presets

Falloff Tools

NewWeight Map Falloff, Incidence Falloff, Falloff Operator, and Falloff Operator tools have been added to
evaluate a weight map applied to amesh operation.

A new Gradient channel has been added to all Falloffs, which allows you to create new shapes to remap the
weight of a falloff.

glTF 2.0 Export to Facebook

Updates have beenmade to the glTF shader. glTF 2.0 export enables another up and coming file format for
Modo. Developed in conjunction with Facebook's new 3D Posts functionality, artists can now create 3D objects
in Modo and then share them on the FacebookNews Feed. Facebook users can then grab, spin, and interact
with the objects to look at them from all angles. The technology presents advertisers with a unique opportunity to
createmore engaging and compelling content, offering artists the opportunity to enjoy interactive 3D
experiences on Facebook.

For more information, see Falloff Operator, File I/OPreferences and Importing and Exporting File Formats.

Hatchet Collection Python Scripts

A selection of Python scripts from the Pushing Point Hatchet Collection has been added to enhance the core
functionality of Modo, making creationmore efficient. A wide variety of new tools are now available from the
interface, which can be used to convert curves, offset curves, make random selections, flatten ngons, andmuch
more.

For more information, see the following tools:

PolyScale Offset Scales a selected polygon on amesh item.

PolyScale Offset Detach Scales a selected polygon on amesh item and detaches it.

Flatten Ngons Flattens ngons in amodel that are not planar, producing a two
dimensional form and smoother properties when rendered.

Triple Fan Splits a selected polygon at a selected vertex point.
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Flip It Flips a selection of polygons to a specified axis.

Open CurveOffset Copies an existing curve(s) and positions it parallel to the existing
curve at a specified offset value.

Closed CurveOffset Copies an existing curve(s), positions it at a specified offset value,
and then joins them together.

Reduce Collapse Tools Removes the selected polygon without destroying the integrity of the
geometry. Selected polygons are deleted but no hole is left behind.
The gap is closed bymerging the neighboring polygons together.

Weight Map Slicer Creates new weight maps on the left and right side of the created
weight map using symmetry.

UV toWeight Converts a UVmap into a weight map using either the U or V
direction.

Morph Slicer Copies an existingmorphmap using symmetry and creates a left
and right version of it.

Edge Zip Creates new SubD topology. An edge selection is welded to the
corresponding edges running parallel to the original edge to create
new topology.

Fix BlackDots Corrects new topology for selected polygons, removing pinched
areas and holes from your mesh item.

Jitter Tool

The Jitter Tool has new Rigid Translate, Rigid Rotate, Rigid Scale, and Lock Stacked options. These options
are used to randomize the position of connected geometry based on their bounding box. All points within the
connected piecesmove the same amount.

MeshFusion Surface Strips

MeshFusion is significantly enhanced with the new Surface Strip creation options. Surface Strips are an
innovative new feature that allows the creation of strip geometry (topology) lying flush on any Fusion Item
surface. This provides a wide range of opportunities for post-Fusionmodeling with procedural operations or
direct modeling of the Fusion output mesh. Themost obvious examples are channels and ridges along arbitrary
paths, but the range of design creation options ismuch wider allowing artists to explore iterationsmore
creatively.

For more information, see Fusion Surface Strips.
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MeshOperations

Triangulate Tool

A new Triangulatemesh operator has been added to convert polygons into triangle pairs used to export
triangulatedmodels.

Merge Meshes

TheMergeMeshes operator can now read replicator items as geometry inputs allowing replicated geometry to
bemanipulated using procedural modeling tools and to convert it to a singlemesh item. In addition, Groups are
now supported by theMergeMeshes tool.

A new Merge Hierarchy option has been added, allowing you to include the child geometry of any parent
source item in amergedmesh. In addition, a new Index option has been added, allowing you to specify which
geometry items tomerge.

Mesh Paint

TheMergeMeshes tool providesmore controlled ways of applying objects to quickly layout environments or
design using amodel bashing technique. For example, with Mesh Paint, artists can quickly drag a bolt along the
hull of a ship or quickly brushmany copies of boulders across a landscape. Linear, Array, Radial Array paint
modes are now available and respects symmetry. Item variations can also be easily painted by using a preset
from the Preset Browser.

Modeling in 3DDimension

Transform, Scale, and Actions Centers 3rd Dimension Modifier

The Transform, Scale and Action Centers tools now allow you tomanipulate anymesh item or component by
moving it in 3rd dimension (forward and backward) in the 3D Viewport by pressing Ctrl/Cmd+Shift+right-
mouse-button.

For more information, see Transform , Scale, and Specifying Action Centers and Falloffs .

Polygon Bevel Tool

New Max Smoothing Angle and Use Vertex Normal Map options have been added.

For more information, see Polygon Bevel.
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Rendering and Shading

A new Frame Range channel has been added to the Render item properties to control which frames to render
during an animation rendering.

For more information, see Render Item: Frame.

Several issueswith parsing render output patterns on the render item have been resolved andmany of the pre-
render sanity checks have also been improved.

TheGLTF Shader now contains constants that are used toWYSIWYGpreview glTFmaterial shaders directly in
theModo Advanced viewport, rendering before exporting to other external renderers. In addition, a Shading
Model dropdown has been added to glTF shader properties, with Physically BasedUnlit settings.

Slide Tool

The Slide tool displays a new handle when using the Vertices selectionmode, allowing you tomove selected
vertices along their connected edges.

UI Changes

A number of UI changes have beenmade to improve your workflow while usingModo.

New Palette Icons

To encourage you to work within a single layout, new tool palettes are now available in themenu bar for easy
access on the top left corner. You can open these palettes while working in any layout.

For more information, see Exploring the Layout.

The Topology Tools Palette now has a new Foreground Opacity setting to allow you to alter the level of
transparency of the foregroundmesh interactively, without having to go into Preferences to change the value.
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Updated Selection Mode icons

Selectionmodifier buttons are now grouped into one central location in themenu bar. For more information, see
SelectionMode Types.

The Items button has been removed from themenu bar. Modo is now implicitly in Items selectionmode until you
select one of component modes; Polygons, Edges, or Vertices.To quickly return to Items mode, click Shift +
Space bar or click the component mode button to deselect the active selectionmode.

The Auto Select mode icon is now displayed as an icon only and acts as a toggle between component and
itemmodes.

Active Tools Highlighted

UI elements are displayed in orange in themenu bar to provide you with a visual awareness of all the various
components used for that activated tool preset.

Center Selection and Pivot Tools

To improve Rigging and Animation workflows, the Center Selection and Pivot Selection icons are now
available from themenu bar.

For more information, see Selecting Items.

Selection Polygon Type DropdownMenu

The Selection Polygon Type icon now has a dropdownmenu allowing you to quickly specifyMaterial, Part,
Smoothing Group, and Selection Set options.

For more information, see Polygon Set Material/Part/Smoothing.
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New Mesh Constraints Button

To quickly identify that you have amesh constraint active, we havemovedMesh Constraints tool from the
Toolbar to menu bar.

When active, the button displays in orange. TheMesh Constraints button now defaults to a background
constraint.

To select a different type of constraint, hold the Alt key and clickMesh Constraints. A dropdownmenu displays,
allowing you to select another constraint type. Once selected, this constraint type is then set as the default and
the next time you activate theMesh Constraints button, it is available.

For more information, see Using Constraints.

Tool HUD Updates

The Tool HUD is now hidden by default. To enable the Tool HUD pressCtrl/Cmd+Tab.

3D Viewport Updates

The 3D (OpenGL) Viewport has the following updates to improve your workflow experience:
• The RayGL button has been removed from the 3D Viewport to unclutter the 3D viewport. It is now
available in the 3D Viewport Styles dropdownmenu. Once activated, a pop-up dialog displays the RayGL
controls.

• A new Topology 3D Viewport preset is available from the 3D Viewport Styles dropdownmenu, which
allows you to quickly work with the retopology tools in the Topology Tools Palette without having to
change to the Topology layout.

• To quickly return to the default Model layout, we have added theModel Base preset to the 3D Viewport
Styles dropdownmenu.

• The Perspective view in the 3D viewport has been changed tomake the view less exaggerated. By
default, the Preferences > Display > OpenGL > Flatness of Perspective setting is now set to 60% .

Work Plane Updates

TheWork Plane tool has been improved to reduce the number of steps to apply your changes. Now you can
make a selection in the 3D viewport and clickWork Plane to align the work plane immediately to what is
selected in the viewport. If you want to access other Work Plane options, press Alt + Work Plane. A dropdown
menu displays. TheWork Plane button displays in orange to indicate that it is active. ClickingWork Plane again
resets it.

For more information, see Using theWork Plane.
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UV Viewport Updates

TheUV Viewport now displays a number of common display option icons tomake it easier to
access rather than having to open the UV Viewport optionsmenu. The following display options are available;
Auto Spans, Show Overlap, Show Distortion, Show Image, and Show Inactive UVs.

New Kits Button

Kit icons are now grouped on the right side of themenu bar to separate them from themodifier buttons.
Functionality has been added to help youmanage these installed Kits. Clicking on a Kits button, such as Afx IO,
displays a pop-up dialog, which lists all of the Kits you have installed and running in your Modo session. You can
quickly set these kits asHidden, Visible, or Expanded from this dialog and the interface is updated.

For more information, see Exploring the Layout.

UVTools

UV Align Improvements

TheUV Align tools have been updated to allow you to alignmultiple UVs at once.

For more information, see Align UV.

UV Commands - Fit UVs Improvements

The Fit UVs tool has new Gaps options to set the border padding. Also, it is now easier to alignmultiple UV
selections in one go.

For more information, see Fit UV.

Feature Enhancements
• File Input: Alembic - FPS import is now supported for non-default time samplers.
• File Output: Alembic - Meshes can now be exported as locators.
• File Output: Alembic - Exporting one less frame than requested is now supported.
• Preset Browser: Cloud Assets and other Preset Browser folders are now updating automatically. The
Application > Preset Browser > Dir Cache Updates is now set to the default preference Always Keep
Updated.

• BUG ID 56860 - Model: The Polygon Bevel tool has a new Use Vertex Normal Map option.
• BUG ID 56885 - Model: The Polygon Bevel tool has a new Max of Smoothing Angle option to compute better
group bevel vertex normals using a sharp vertex.

| Release Notes for Modo 12.0v1



12

• BUG ID 57872 - Model: The Arc tool's handles are now set to 15 degree increments, allowing you position the
radius precisely where you want by dragging the end angle handle while holding the control modifier key.

• BUG ID 57899 - MeshFusion: TheMore Fusion tools have been replaced with the new Fusion tools and other
outdated buttons from the toolbar above the 3D Viewport have been removed.

Bug Fixes
• MeshFusion: The default New Fusion... Strip Profile value was set to 50%, which had no particular
significance. Setting it to 100% is required for Surface Strips.

• SDK: The ILxDTBBadgeOverride interface for SDK was out-of-date.
• UI: The search field in the Add Item dialog did not clear when opened.
• UI: Support for form icons on attr.formPopover was needed.
• UI: Tooltips in forms did not show why a control was disabled.
• UI: Alternative Layouts was out-of-date.
• BUG ID 34246 - UI: Pressing Ctrl/Cmd+6 and selecting the Same as Active piemenu did not toggle correctly.
• BUG ID 46250 - Particles: Scaling a particle cloud item used as the point source for a replicator, caused the
replicas to scale relative to their point ID and resulted in non-uniform scaling.

• BUG ID 49767 - Procedurals: Scenes, which contain a UV constraint modifier for a texture, sometimes failed
to load after saving due to amodifier dependency loop.

• BUG ID 50016 - MeshFusion: Selecting the Fusion view from the 3D viewport preset while using the
Advanced view caused the Selected Item Drawing to switch from Filled (if set) toWireframemode. The
sourcemesheswere not highlighted in orange color when theywere selected and the wireframes on a Fusion
Item did not display as expected.

• BUG ID 51759 - Procedurals: The Curve Fill tool producedmultiple hole issues.
• BUG ID 53352 - Render: Mesh Lights did not continue to work when the original mesh was hidden.
• BUG ID 53865 - Color: The Default Numeric Colorspace selection did not save in the config file.
• BUG ID 54134 - Render: Render time increased drastically when disabling the Transparent Shading output in
a scene.

• BUG ID 54354 - Model: The Edge Bevel tool created bad UVs on discontinuous edges.
• BUG ID 54675 - Particles: Replicator particle rotation outputs did not work as expected.
• BUG ID 55145 - GL: The Default viewport lights did not cast shadows in the Advanced Viewport.
• BUG ID 55500 - GL: Setting the Advanced viewport Effects > Material option to Basic displayed Unreal
materials aswhite.

• BUG ID 55536 - Schematic: Node connections causedModo to randomly crash.
• BUG ID 55594 - Advanced Viewport: Wireframesweremissing from orthographic views.
• BUG ID 55780 - GL: Textures applied, using UDIM's, didn't display correctly in the Advanced Viewport.
• BUG ID 55787 - Rendering: The Scratches procedural texture sometimes produced NaNs in the Preview
viewport and Render Display.

• BUG ID 55852 - Procedurals: Hide/Unhide polygons did not work as expected with an edge selection based
on aMeshOperation.

• BUG ID 56182 - Model: Undoing on a second added edge selection didn't remove the selection.
• BUG ID 56198 - File Input: Resizing a *.png file causedModo to crash.
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• BUG ID 56301 - Shader Tree: Adding an Environment item below the default environment broke the shading
of the original environment.

• BUG ID 56461 - UI: Copying and pasting an object using the Items selectionmode did not work as expected.
• BUG ID 56594 - UV: UV backdrop selection did not work as expected.
• BUG ID 56673 - GL: Disabling aMeshOp did not update in the 3D viewport correctly.
• BUG ID 56860 - Procedurals: The Polygon BevelMeshOp tool caused distortion when used on flat ngons.
• BUG ID 56885 - Model: The Polygon Bevel tool produced unexpected results.
• BUG ID 56891 - Deformers: Moving theMagnet Effector in theMeshOps tab caused unlinking of the effector
locator.

• BUG ID 56904 - Render: Rendering a particular scene took longer than expected.
• BUG ID 56918 - Procedurals: The Edge Bevel tool did not produce the expected results.
• BUG ID 56982 - SDK: Using setParent without an index caused the order to be reversed compared toModo
11.1.

• BUG ID 57074 - File Input: Streaming an Alembic file (*.abc) causedModo to crash when scrubbing through
the timeline.

• BUG ID 57100 - MeshFusion: Adding a trimmedmesh to a compound trim causedModo to crash.
• BUG ID 57133 - UV: Smooth Shift and Sketch Extrude tools caused discontinuousUV issues.
• BUG ID 57169 - Model: Customizing specificmouse inputs did not work as expected.
• BUG ID 57176 - LinuxOnly - File Output: An integrated Sketchfab Kit did not work as expected.
• BUG ID 57227 - File Output: Exporting an Alembic file caused amemory leak.
• BUG ID 57233 - File Output: Exporting an Alembic scene using duplicatemesh items created a larger output
file than expected.

• BUG ID 57252 - Headless: Redundant OpenGLwarningswere produced bymodo_cl.
• BUG ID 57334 - MeshFusion: Clicking Switch Width Mode did not refresh properties instantly.
• BUG ID 57353 - Particles: Procedurally assigned selection sets were invisible for Particle Modifiers.
• BUG ID 57368 - UV: Tool handleswere scaled in the UV view whenUse Image Aspect was enabled.
• BUG ID 57369 - UV: The UV Symmetrize command did not work with selected vertices or edges.
• BUG ID 57370 - UV: UV Symmetry > Grow Selection (Shift+Up Arrow) command failed to work.
• BUG ID 57397 - Presets: Rendering a preview preset shape (Sphere, Plane, or Preset Sphere) and saving
the image for use as a preset thumbnail, did not display the correct colorspace in the Preset Browser.

• BUG ID 57402 - Shader Tree: Dragging-and-dropping an image from the Images list moved selected texture
layers unexpectedly.

• BUG ID 57407 - UV: Merge verticesmoved the center to an incorrect position in the UVmap.
• BUG ID 57452 - Licensing: License discovery order took a long time to start-up for users with sign-in licenses
for Modo and RLM licenses for other Foundry products.

• BUG ID 57459 - UI: The 3D viewport settingswere not saved using the File > Config Save command, unless
the layout was switched first.

• BUG ID 57464 - UV: The Tear Off option did not work as expected for the Box Transform tool.
• BUG ID 57501 - File Output: Exporting a scene to an Alembic file with deformed instances lost the unique
animation on the instances.

• BUG ID 57519 - File Output: Exporting an animation to an Alembic file did not export all frames.
• BUG ID 57532 - Model: With vertex snapping enabled using the Radial Array tool caused the points to shift.
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• BUG ID 57577 - File Output: glTF - Animation exports produced validation errors.
• BUG ID 57579 - File Output: glTF - Skinned glTFs produced validation errors.
• BUG ID 57606 - File Input: DXF - Changing the operating system (OS) to a specific locale, truncated floating
points and causedModo to pixelate the scene.

• BUG ID 57613 - UI: Disabling a tool's command in the FormEditor did not work as expected.
• BUG ID 57616 - UI: Accessing Help > Foundry User Community... produced browser security warning error.
• BUG ID 57639 - Render: Some systemswith higher numbers of cores and threads using NVidia profiles
caused poor rendering performance.

• BUG ID 57671 - Procedurals: The Polygon Subdividemesh operation tool produced bad results.
• BUG ID 57737 - File Output: glTF - Exporting a *.glb file did not provide a warning about requiring the swizzling
to be set to RGB for Base Color.

• BUG ID 57773 - MeshFusion: Copying and pasting Fusion items causedModo to crash.
• BUG ID 57783 - File Output: Setting the Export Type to Export Selected from File I/O glTF v2.0 I/O
preferences and exportingmultiple mesh items produced a number of errors in the glTF Viewer.

• BUG ID 57800 - Topology: Using the Topology Pen tool with a Falloff causedModo to crash.
• BUG ID 57804 - MacOS only (hardware specific) - GL: supportedgfx.cfg did not support newer NVIDIA web
drivers (379 to 399) onMacOS systems.

• BUG ID 57845 - Model: The Contour tool did not create geometry or curves.
• BUG ID 57858 - MacOS Only - Procedurals: Opening or importing some scenes usingMeshOps caused
Modo to crash.

• BUG ID 57858 - UI: The B-Spline curve tool wasmissing from the tool panel while using the Layout layout.
• BUG ID 57867 - File Output: Alembic custom frame range exported unexpected amount of samples.
• BUG ID 57878 - File Output: Alembic - Exporting a scene with instances that have the deform option enabled
causedModo to crash.

• BUG ID 57884 - UI: Particle UVT and Particle Snapmodifiers were in the wrong Preset Browser category.
• BUG ID 57896 - File Output: Alembic - Clicking the abort button in the progress dialog during export caused
Modo to crash.

• BUG ID 57901 - Content: The spelling of the Spiral Curve tool was incorrect in theMeshOperation list.
• BUG ID 57913 - Particles: The Particle Snapmodifier modes did not have user names and tooltips.
• BUG ID 57945 - MeshFusion: TheMore Fusion > Prep Selected command displayed unnecessary error
messages.

• BUG ID 58007 - Procedurals: Adding theWork Plane to the toolpipe causedModo to crash.
• BUG ID 58042 - File Output: Saving a specific scene inModo 11 or 12 causedModo to crash.

Known Issues Specific to this Release
This section covers known issues and givesworkarounds for them, where appropriate.

Advanced Viewport
• BUG ID 56706 - Unity and Unrealmaterials are not displayed correctly when first loaded.
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As a workaround: Enable and then disable the visibility of the Shader Tree textures.
• BUG ID 50810 - Anisotropic texture filtering is lower quality than in the Default viewport.
• BUG ID 46995 - Ambient Occlusion display in the Advanced viewport is affected by selected itemwireframes.

You can disable Show Selection in the Visibility options or disable wireframe drawing on the activemesh
layers.

Animation
• BUG ID 53661 - Selecting actions does not always select the correct one. This is caused by copying actions.

As a workaround, manually edit the tags on the broken actions by selecting them in theGroups tab, then save
and reload the scene.

Assemblies
• BUG ID 36452 - Assemblies exported from the Item List context menu result in poor visual layout of nodes on
import.

As a workaround, you can save assemblies from the Schematic viewport.

Baking
• BUG ID 50671 - Baking displacement maps can cause UV seams to be visible, and the baked displacement
map to show quilting effects and other render artifacts.

• BUG ID 49437 - The Bake Channel Swizzling option can’t bake to texture alpha.

Color Management
• BUG ID 49244 - Windows only: With Perform Color Correction on, setting a default scene to a scene with a
mesh that has a position channel crashesModo at launch.

As a workaround, use System > Reset Preferences to reset to defaults or move/remove the default scene.

Default Viewport
• RGBA textures only draw correctly in the Advanced viewport. In the Default viewport, any unsupported
texture effect on an imagemap is drawn as diffuse color when the layer is selected in the Shader Tree.

Deformers
• BUG ID 56726 - Deformed Instances that are off-screen are incorrectly drawn at the origin.
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File and Image I/O
• BUG ID 56862 - Modo for SolidWorks Kit: Modo crasheswhen importing the same SolidWorks file twice in
oneModo session. This bug only affects import using the kit, not direct imports (File > Import).

As a workaround: Before importing a SolidWorks file for the second time, exit and restart Modo.
• BUG ID 55439 - Alembic imported convex polygonswith at least two close to co-linear edgesmay not draw
correctly in GL (appearing asmissing triangles).

As a workaround: Import using the new Alembic Streaming options. Set the Polymesh streaming options to
Alembic Streaming Meshes (polys only, force all). Alternatively, select the basematerial in the Shader
Tree and enable Surface Normal > Double-sided, then change the Smoothing angle to 180.

• BUG ID 50198 - Alembic scenes don't export some surface items, including staticmeshes and procedural
shatter items.

• BUG ID 49728 - Exporting selected layers (from the Item List context menu) to .fbx doesn't export instances,
unless the original mesh is also exported.

To resolve this, set the .fbx preference to Export Selection and use Export As….
• BUG ID 47036 - Color management in .svg images is not currently supported. This is a side-effect of a bug fix
where the largest allowable image size (64k x 64k) was always used when color correction was enabled.

• BUG ID 46962 - Rendering .svg images used as stencil maps for displacement or for layer masking can be
very slow.

Fur
• BUG ID 35731 - Fur length textures can’t be edited with the Stretch tool.

Use different fur length drivers, such as hair guides or vector vertexmaps.

General
• BUG ID 49514 - MacOS X only: Runningmodo_cl before running the UI Modo application breaks code
signing.

As a workaround, start the UI version of Modo once, before runningmodo_cl on any systemwhere you later
intend to use the UI version.

GL
• BUG ID 55816 - Wireframes are washed out on transparent surfaces in the Advanced viewport.

As a workaround, avoid transparencywhenmodeling or doing work where wireframes are needed.
Alternatively, use the Default viewport.

• Windows only: Using Raptr can causeGL driver crashes inModo.
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• BUG ID 58003 - GameNavigationmode (camera rotation) does not work in a floating 3D view (palette or
separate window).

As a workaround, useGameNavigationmode only in docked 3D views (views that are part of a Layout).

• BUG ID 57955 - Clicking on the VR layout tabmay crashModowhen using a systemwith a RadeonWX-
series graphics card. This is due to a driver bug and should be fixed by AMD in a future driver release.

Input Devices
• BUG ID 51741 - MacOS X only: Modo sometimes becomes unresponsive when using the combination of a
click-drag in a tree view (for example, when toggling the visibility of two successive items in the Shader Tree),
followed immediately by a two-finger scroll gesture on some devices, including laptop trackpads and theMagic
Mouse.

As a workaround, change to a 3-buttonmouse (recommended to fully access all of Modo's features).
• BUG ID 35856 - Linux only: Plugging in aWacom tablet while Modo is running can cause undesired
movement. This cannot be fixed, due to a limitation of the hardware driver.

To avoid this, plug in the tablet before application startup or restart.

Item List
• BUG ID 53209 - Group creation (Ctrl + G) places the new group folder at a random position in the Item List, if
the items are not selected in a top down sequence.

As a workaround, select the items being grouped from top to bottom in the Item List before grouping (Ctrl +
G).

Mesh Fusion
• BUG ID Bug 56973 - If a Trim Fusion role is assigned to an object and then it is dragged and dropped onto a
Primary, the dropmenu does not contain the Trim boolean options.

As a workaround, use either the Fusion Buttons (Tool palette - Set Mesh Role & Apply section) or PieMenu
(Apply SubtractionApply Intersection or ) when initially adding Trims to each Fusion Item (Trims can
contribute tomultiple Fusion Items). If initially applied with either of thosemethods, all subsequent Drag &
Drop optionswill be supported.

Modeling
• BUG ID 58018 - Using theMesh Paint tool and changing a variable deletes the last paint updatemade on the
mesh.

• BUG ID 32728 - Zooming out with a Space Navigator alters theWork Plane position.
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Network Rendering
• BUG ID 48325 - Sceneswith image sequences rendered with Full Frames use the wrong image sequence
number on slavemachines.

As a workaround, use File > Consolidate Scene, then render the scene using a shared network folder
(Preferences option under Rendering > Network Rendering).

• BUG ID 36986 - Slaves render hiddenmeshes. Sincemesh hide state is not stored in the scene, when that
scene is transferred to the slaves, the state is lost. Themaster respects the hidden state, however.

As a workaround, if the intent is to avoid rendering, toggle the visibility for the item or render or open System >
Preferences > Rendering and disable Use Network Render Nodes.

• BUG ID 30318 - Network Rendering doesn’t support Realflow particles.
• BUG ID 25636 - Frame passes are not supported.
• Several Bugs - While it apparently worked inModo 902, in some cases, Network Rendering was not
implemented to support baking. Changes toModo in the 10-series apparently broke what wasworking for
some artists, so the functionality has been disabled.

As a workaround, Modo 10 implemented the ability to Network Bake using Bake Items and an external render
controller. For more information, please see the SDKWiki.

Node Shading
• BUG ID 50642 - Nodal shading does not support UDIMs.

Painting/Sculpting
• BUG ID 41682 - Textures are not always updating in Preview/Render when painting on an imagemap.

You can save and reload the image to force the update.

Particles
• BUG ID 44551 - Surface Particle Generatorsmay not update with changes to a Density Gradient Input set to
Slope.

As a workaround, choose Distance to Locator or any other setting from the Density Gradient Input
dropdown, then change it back to Slope.

• BUG ID 34925 - Re-opening scenes saved with large particle caches can cause problems.

To avoid such issues, delete the cache before closingModo, or export the particles to .csv cache files or
Realflow .bin files. You can do this by attaching one of those nodes to the Particle Simulation item in the
Schematic viewport, and clicking Cache Simulation.

• BUG ID 57990 - Surface Particle Generators don’t work with StaticMeshes.
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• BUG ID 57989 - StaticMeshes no longer generate particles as Surface Emitter surfaces.

• BUG ID 57609 - Point count and visibility issueswith the Curve Particle Generator.

Preset Browser
• BUG ID 55882 - Pinning the Viewport Textures preset browser crashesModo on restart.

As a workaround, runModo in Safe Mode and select System > Reset Preferences or manually delete the
main config file.

Preview
• If a high polymesh is not visible, the Preview baking output will be incorrect.

As a workaround, reset Preview to fix the baking.

Procedurals
• BUG ID 56908 - Merge Meshes can corrupt UVs created inMesh Ops.
• BUG ID 56318 - Procedural duplication of MeshOps in a Deform folder creates errant Mesh Ops list.
• BUG ID 56317- Duplication of Procedurals does not work with the Select By Previous Operation tool.

As a workaround, manually edit the duplicate's Select By Previous OperationMeshOps.
• BUG ID 54738 - A duplication of any item that is aMergeMeshes Source (For example, aMesh Item,
Procedural Item, or Fusion Item), any duplicates (duplicate or instance) are added to theMergeMeshesOps
List as a source.

As a workaround, remove the unwanted additionalMergeMesh Sources (regardless of the type of source) in
theMesh Ops List using the X icon in that list next to eachMergeMeshes source.

• BUG ID 52149 - Curve Extrudemesh operation: The Path Segment Generator's Align to Normal option
doesn't work when using a Bezier with zero-length tangents.

As a workaround, rotate the polygons to point toward the +Z before extruding or make sure there are no zero-
length tangents.

• BUG ID 53623 - Editingmeshes used by hiddenmesheswith mesh operations appliedmay cause slow
performance.

Projections
• BUG ID 49473 - Projections are incorrect if the projecting camera is set to Vertical film fit mode and the width is
less than the height.

• BUG ID 43771 - Camera projections from non-render cameras show distortion in GL and baking.
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To avoid this, make sure that the projection camera has a filmwidth-to-height ratio that matches themain
render camera.

References
• BUG ID 44492 - If a scene that already contains references is referenced, the shading of the original
referencesmay not persist.

As a workaround, limit sceneswith shading to one level of reference.
• BUG ID 41119 - Reloading a reference after replacing it with the same file can causeModo to crash.

Rendering
• BUG ID Bug 55663 - Motion Blur applied on a curve in aMeshOperation no longer works.
• BUG ID 53411 - Mesh lights or any direct light too close to a surface can produce fireflies (hot pixels) in some
cases.

As a workaround, use aMaximum Radiance higher than 1W/srm2 to reduce the bias.

• BUG ID 53793 - Rendering using a Dual CPU with 72 threadswas significantly slower than expected.

As a workaround, anymachine that hasmore than 32 cores, performance will be better if you limit rendering to
half the number of cores you have.

• BUG ID 53184 - Value presets created for material Subsurface Scattering samples in Modo 10.1 or earlier
now show on the render item instead.

• BUG ID 52730 - The Vertex Illumination Bake command doesn't work as expected, when themesh has
transform channels.

As a workaround, freeze the transforms in themesh properties.

Rigging
• BUG ID 27244 - Duplicating joints in a boundmesh retains influences from the original joint chain.

Scripting
• BUG ID 53458 - Right-clicking or running a script in the Script Editor can lock up input to Modo.

As a workaround, click in the top window of the Script Editor, use themainmenus, or change to another
application, then switch back toModo.

Shader Tree
• BUG ID 37858 - In the Shader Tree, choosing a group fromAdd Layer > Image Map > (use clip browser)
fails.
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Towork around this issue, in the Clip Browser, choose a single image instead of the group, and then change
to the image group using the Texture Layer's Properties tab.

• BUG ID 30947 - Layer masking displacement does not work unless you drag and drop themasking layer onto
the displacement layer.

• BUG ID 57874 - CustomMaterials that define their own smoothing properties (such as the Skinmaterial), no
longer smooth themesh correctly.

Unreal and Unity Materials
• BUG ID 50701 - Unrealmaterial Ambient Occlusion does not bake correctly in Modo.
• BUG ID 50700 - There is no way to visualize the Unreal SubSurface Color effect in Modo.
• BUG ID 50451 - On some graphics cards, Unitymaterial may cause flickering in the Advanced viewport when
used with bumpmaps and shadows.

UI
• BUG ID 55759 - Transforming objects can cause the Items Properties panel to flicker.
• BUG ID 55571 - Resizing the dopesheet in Zen crashesModo 11.1, but not in Modo 11.0.
• BUG ID 55185 - Text in the viewport icon buttons is not visible in the Advanced viewport on someMac
OS/AMD configurations.

As a workaround: UpgradeMacOS to 10.12 or 10.13.
• BUG ID 44496 - MacOS X only: Disabling Affect System Color Dialog in Preferences > Rendering > Color
Management, and using the system color picker caused colors to darken with each use of the color picker.

This is due to anOS X issue, which requires the color profile in both themonitor settings and color picker to be
set to sRGB IEC61966-2.1.

• BUG ID 44896 - Dragging and dropping an image from disk into the Clips list doesn’t work.

If the Clips list is empty, drop the image onto the bar at the top, otherwise drop it above or below other images
in the list.

• BUG ID 43162 (Windows only) -Setting a custom text size affectsModo's text drawing.

As a workaround, go to the compatibility settings by right-clicking theModo shortcut or executable, and turn off
font-scaling for the application.

UV
• BUG ID 56967 - If UV distortion is enabled in both the UV and 3D viewport, editing themesh in the 3D view
causes the UVs to turn black.

As a workaround: Toggle the UV texture visibility or avoid enabling Show Distortion on in both views.
• BUG ID 55891 - Show UDIM does not display the UDIM number in the UV viewport.

As a workaround, enable the Auto Spans option.
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• BUG ID 55582 - The Tear-off modifier keys (Shift+ Ctrl) are live in the UV Transform tool, meaning the Tear-
off state changes during the drag if the keys aren’t held down.

• BUG ID 55564 - The UV Distortion and UV Vertexmaps are no longer accessible. This is due to bugs and
crasheswith these ‘internal’ maps being visible to users. Modo 11.2 will introduce features to replace prior
uses of thesemaps.

Developer Notes
• BUG ID 53988 - SDK: The item.channel query didn't read evaluated strings correctly.
• BUG ID 55473 - SDK: A reference scene loaded twice did not return geometry in CLxSurfaceVisitor.Sample
().

• BUG ID 55749 - SDK: Viewing graph for a plugin's alpha channel, if no keyswere set, causedModo to crash.
• BUG ID 56467 - SDK: Reading an item graphs in a command's enable function sometimes causedModo to
crash if the scene changed.

• BUG ID 56697 - SDK: Rendercache crashedModowhen closing the scene.
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